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Q: How can I calculate the Area Under the Curve for a generic function?

A: You can calculate the Area Under the Curve for any generic function of parameters or of 
compartmental masses that can be associated to a sample, such as in

s1 = q1^2 + q2 / 5 + alpha

where alpha is an adjustable parameter and q1 and q2 are the masses in compartment 1 
and 2, respectively. The Area Under the Curve can then be calculated by checking Compute 
Sample AUC's in the Compute Settings window and can be viewed using the AUC's option 
in the Show menu.

Q: How can I calculate the Area Under the Curve to infinity?

A: SAAM II does not calculate the Area Under the Curve to infinity, but only up to the end 
of the experiment. Depending on how long the experiment lasts, the difference between 
the calculated AUC and the AUC to infinity can be substantial.

A “rule of thumb” to calculate the AUC to infinity is to extend the experiment time for at 
least 3 times the inverse of the slowest system time constant.

However, you should also check that, for increasing values of the experiment time, the AUC 
does not change substantially.

Q: How can I solve a differential equation that cannot be written in compartmental 
form?

A: Generate a compartment with an exogenous input:
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The corresponding differential equation is then:

q1' = +ex1

The exogenous input ex1 can now be defined equal to any function of the parameters, of 
q1, or of other compartmental masses or parameters.

For example, the following system of equations can be written using two compartments and 
two inputs:

q1' = +ex1 = r * q1 – g * q1 * q2

q2' = +ex2 = h * q1 * q2 – m * q2

These equations describe the well-known Lotka-Volterra model for predator-prey 
interaction, independently developed by Lotka in 1925 and Volterra in 1926 (see e.g., R. E. 
Keen and J. D. Spain. Computer Simulation in Biology: A BASIC Introduction. Wiley-Liss, 
New York, 1992, pp. 113-122, or G. E. Hutchinson. An Introduction to Population Ecology. 
Yale University Press, New Haven, Connecticut, USA, 1978).

Also, refer to the following Q/A sections herein:

• 'How can I solve a compartmental model where the rate constants are time-varying?'
• 'How can I solve a second-order differential equation?'

for more information about entering user-defined differential equations in SAAM II.

Q: How can I solve a second-order differential equation?
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A: This possibility can be useful for various kinds of metabolism and pharmacokinetic 
models. To write any first-order, linear or nonlinear, differential equation in SAAM II, please 
see also the Q/A section entitled, 'How can I solve a differential equation that cannot be 
written in compartmental form?', herein.

For the equation to be second-order, we need to go through a little algebra.

Suppose we have the following second-order (i.e., with a second derivative in at least one 
term) equation:

d^2(q1) / dt^2 = 0.5 * dq1 / dt – 0.1

The transfer function relative to this system is:

H (s)=
NUM (s )
DEN (s)

 

This equation can be written ins state-space form, that is:

q(t) = Kq(t) + Bu(t)

s(t) = Cq(t) + Du(t)

This could be done with any matrix language, such as MATLAB (The MathWorks) or O-
Matrix (Harmonic Software).

The coefficients of the matrix K are:

[0.5000 0 −0.1000
1.0000 0 0

0 1.0000 0 ]
The other matrices are all identity.

The vector B is equal to:

[100]
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The vector C is equal to:

[001]
The vector D is equal to:

[000]
The corresponding differential equations are:

q1(t) = +0.5 * q1(t) – 0.1 * q3(t)

q2(t) = +1.0 * q1(t)

q3(t) = +1.0 * q2(t)

This is not a compartmental system; however, it can be implemented in SAAM II (see the 
Q/A section, 'How can I solve a differential equation that cannot be written in 
compartmental form?', herein). The input should be a bolus input in compartment 1.

The output function s1 = q3 provides the desired solution.

Q: How can I solve a compartmental model where the rate constants are time-varying?

A: In SAAM II, it is possible to define time-varying rate constants by simply entering, either 
in the Loss or Transfer Attributes Window or in the Equations Window, the equation defining 
the rate constant. For example, a Michaelis-Menten type of reaction can be defined by 
using this single-compartment model:
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where the rate constant k(0,1) is defined as:

k(0,1) = Km / (Vmax + q1)

thus defining a nonlinear reaction. k(0,1) will disappear as a parameter, and Km and Vmax 
will appear instead in the parameter window. 

The same holds for a generic parameter in the model: any parameter could in fact be 
defined as time-varying.

For more information about the capabilities of SAAM II for entering user-defined generic, 
multiple-order, linear or nonlinear differential equations, also refer to the following Q/A 
sections herein:

• 'How can I solve a differential equation that cannot be written in compartmental 
form?'

• 'How can I solve a second-order differential equation?'

Q: How can I perform a double integration of a generic function?

A: You can calculate the Area Under Curve (integral) for any model or generic function in a 
SAAM II Compartmental model by setting the Compute Sample AUC's option in 
Computational Settings (see the Q/A section, 'How can I calculate the Area Under the 
Curve for a generic function?', herein). An alternate method can also be used to calculate an 
AUC that takes advantage of specific characteristics of the compartmental model itself. By 
combining the two methods, it's easy to perform a double integration.
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This alternate method for computing an AUC uses a compartment and an input as shown in 
Figure 1. Throughout an experiment, the compartment will accumulate the total amount of 
material from the input. If the input is a constant infusion of 2.0 throughout an experiment 
of duration 100.0, for example, the amount of material in the compartment at any time will 
be 2.0 * t. At the end of the experiment, the total will be 2.0 * 100.0 = 200.0, the AUC of 
the input function.

To perform a double integration, simply set a sample equal to the contents of q1. For 
example, follow these steps:

1. Start the Compartmental Application.

2. Click Experiment Attributes... on the Set menu. In the Experiment Attributes 
dialog, enter 100.0 for the End At value. Click the Done button to close the dial.

3. Draw a single compartment by clicking on the Compartment tool in the Toolbox; 
then, click anywhere in the main model (white) window.

4. An experiment is needed in order to use the computational machinery in 
Compartmental. Click the Experiment button in the Toolbox. Use the default values 
in Create Experiment and click the Create button.

5. To add the input, click on the Input tool in the Toolbox, click on the compartment, 
q1, and then click on the model window background (since inputs may be attached to 
multiple compartments, the background click indicates that you are done selecting 
compartments for this input).

6. To add the Sample, click on the Sample tool in the Toolbox, click on the 
compartment, q1, and then click on the model window background. Your model 
should now appear as shown in Figure 1.
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Figure 1

7. Open the Exogenous Input window by double-clicking on the input object, ex1 (the 
syringe). For Input Type, click the Equation radio button. Set up the time for the 
input by entering 0 for Event Start and 100.0 for Event Stop (the end of the 
experiment). Click in the Equation entry area and enter the exponential equation, ex1 
= 5000.0 * exp(-0.04 * t). Click the Add button on the right to add this equation to 
the input list in the top pane of the window. Click the Done button.

8. Click Settings on the Compute menu to open the Computational Settings dialog. To 
activate the Area Under Curve (AUC) functionality, click Compute Sample AUC's. 
Click the Done button.

9. The model construction is now complete. By default, the sample, s1, is set equal to 
the contents of compartment q1. To check, open the Sample Attributes dialog by 
double-clicking the sample object s1, and then close it when done.

10.Solve the model by clicking Solve on the Compute menu, or by clicking the Solve 
toolbar button.

11.To view the original exponential function, click on the input object, ex1 (it should 
become highlighted in yellow), and then click on Quick Plot on the View menu. To 
see the AUC (integral) of the exponential function, click on the compartment q1 to 
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highlight it, and then click on Quick Plot on the View menu again. To bring the first 
Quickplot back to the front, click on Quickplot – ex1 on the Window menu. You 
should see plots that look like Figures 2 and 3.

Figure 2
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Figure 3

12.To view the AUC of the first integral, open the Area Under Curve window by clicking 
AUC's on the Show menu. The window should show the AUC of the s1 curve equal to 
9.4322e+006.

13.When done, close each of the three windows and exit the Compartmental 
application.

Q: How can I calculate the derivative of a compartmental mass?

A: In the Equation window, the differential equations are available for the model. For 
example, for the example two-compartment model in study_0.stu, the following differential 
equations can be viewed by opening the Equation window and selecting Diff. Eq. From the 
View menu:
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q1' = k(1,2) * q2 – k(2,1) * q1 – k(0,1) * q1 + ex1

q2' = -k(1,2) * q2 + k(2,1) * q1

where q1 and q2 are the masses in compartments 1 and 2, respectively. The derivative with 
respect to time of q1, for example, is given by the expression k(1,2) * q2 – k(2,1) * q1 – 
k(0,1) * q1 + ex1, which can be easily calculated off-line, by simply writing in the Equation 
window and then plotting an expression like:

derivative = k(1,2) * q2 – k(2,1) * q1 – k(0,1) * q1 + ex1

Q: How can I analyze an algebraic model in the Compartmental application?

A: Although the Compartmental application is designed for complex compartmental 
models, it can handle algebraic models as well. They must, however, be constructed within 
the experimental framework used in the Compartmental application.

A simple example is to construct the model for a straight line and fit it to data. Follow these 
steps:

1. Start the Compartmental application.

2. Click Experiment Attributes... on the Set menu. In the Experiment Attributes 
dialog, enter x for the Independent Variable name and 10.0 for the End At value. 
Click the Done button to close the dialog.

3. An experiment must be created in order to use the computational machinery in the 
Compartmental application. Click the Experiment button in the Toolbox. Use the 
default values in the Create Experiment dialog and click the Create button.

4. A sample object is the link between the function that will be defined and the data to 
which it will be fitted. To create a sample, click on the Sample tool in the Toolbox, 
and then click anywhere in the main model (white) window. The sample should 
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appear as a red circle labeled s1 as shown in Figure 4.

Figure 4
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5. Double-click on the sample object to open the Sample Attributes dialog. The name 
for the data could be entered in the Associate with Data Name area now, but, for 
this example, it will be done after the data has been typed in. Click in the Equations 
area, enter the equation shown below and then click the Done button.

s1 = m * x + b

6. Open the Data window by clicking Data on the Show menu. Type in the data as 
shown in Figure 5. To check that the format is satisfactory, click Check Data Format 
on the Edit menu. If a mistake has been made, an error message will appear; 
otherwise a Data Format is okay message will appear at the bottom of the Data 
window. Click the X in the upper right corner of Data window to close it (or click 
Close on the File menu).

Figure 5

7. To inform the application that the data labeled s1_data is to be associated with the 
sample s1, click Associations in the Show menu to open the Associate Sample and 
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Data dialog box. In the dialog, s1 (in the left pane) and s1_data (in the right pane) 
should already be highlighted. Click the Associate button. The entry in the left pane 
will change to s1 : s1_data to indicate that the sample and data are now associated. 
Click the Done button to close the dialog. Notice that the sample object is now solid 
red, which indicates that s1 is now associated with data.

8. Before the model can be fitted to the data, approximate values are required for the 
parameters. Open the Parameter window by clicking Parameters on the Show menu, 
or by clicking the Parameters toolbar button. Notice that m and b are listed as 
parameters. Parameters are defined as any undefined variables in the model, i.e., 
they appear only on the right of the equal sign in one or more equations. In this case, 
m and b appear in the equation for s1. Approximate values and upper and lower 
limits are required for each parameter to constrain the n-dimensional space (n = 2 
here) that the optimizer must search for the values that minimize the objective 
function, i.e., create the best fit of the model to the data. Since the y-intercept, b, is 
already highlighted, enter 0.0 for the Value, -1.0 for the Low Limit, 1.0 for the High 
Limit, and then click the Save button. Next, double-click the line in the list containing 
m to place it into the edit area at the bottom of the window. Enter 1.0 for the Value 
and click the Save button. Notice that default values are supplied for the upper and 
lower limits. Click the Done button to close the window.

9. All information required to fit the model to the data has now been entered. Click Fit 
on the Compute menu, or click the Fit toolbar button.

10.Reopen the Parameter window. Notice that the values for both m and b have been 
adjusted to provide the best fit on the model to the data. Close the Parameter 
window.

11.To view a plot of the fitted line, click Plot Manager on the Show menu or click the 
Plot Manager toolbar button. The Plot Manager dialog will appear.

12.To create a new plot, click the + button on the lower left of the Plot Manager dialog. 
An empty plot view and the Plot and Table Variables dialog will appear.

13. In the left pane of the Plot and Table Variables dialog, select the s1 : s1_data entry, 
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and click the Done button. The plot view should now appear as in Figure 6.

Figure 6

14.When finished, close the Plot Manager dialog, save the model (if desired), and exit 
the Compartmental Application.

Q: How do I handle data and change conditions or inputs that occur simultaneously?

A: This is a situation that can occur whenever something in the model makes the quantity of 
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material in a compartment discontinuous at a specific time point. Most commonly the 
discontinuity is caused by either a change condition or an exogenous input occurring at the 
same time data is being measured.

For example, suppose the single compartment model in Figure 7 has a bolus input at time 0, 
and, at time 10.0, q1 = 40.0 just before a second bolus of magnitude 60.0 is administered. 
The question is whether the measured data value at time 10.0 should be 40.0 or 100.0. The 
safest way to handle this situation in the Compartmental application is to make the time for 
the second bolus 10.0, and to make the measured data time either slightly before or slightly 
after 10.0 depending upon whether or not the measurement includes the bolus.

Figure 7

Unfortunately, users commonly make both occur at exactly the same time, so the application 
must make an assumption on how to handle simultaneous discontinuities and 
measurements. To resolve the ambiguity, the Compartmental application assumes that any 
discontinuities occur prior to the data measurement. In the preceding example, the 
application would compute q1 = 100.0 at time 10.0, and any data measured at time 10.0 
must include the second bolus.

Using the same example, where q1 = 40.0 at time 10.0, suppose instead of a second bolus, 
the contents of q1 are emptied using a change condition to set q1 = 0.0. at time 10.0. 
Should a measurement of the contents of q1 at time 10.0 show that q1 = 40.0 or q1 = 0.0? 
As before, the application assumes that any discontinuities occur prior to the data 
measurement, so the measured value for q1 should be 0.0.
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Internally, the Compartmental application handles this problem by maintaining two time 
values at every discontinuity. If the Values window were examined for the above example, it 
would show two time 10.0 entries. One would contain the computed value for q1 just 
before, and the other would show the computed value just after, the discontinuity. 
Numerically, the two times appear to be 10.0, but internally, the first is a value just slightly 
prior to 10.0, and the associated value for q1 would be prior to the bolus or change 
condition. Any data measured at time 10.0 would appear at the second time 10.0 entry 
where any discontinuities have already occurred.

Q: How can I use data to simulate a function?

A: A function can be approximated by knowing values along its curve, and the SAAM II 
Compartmental application can use linear interpolation on these values to simulate the 
original function.

The first step is to enter the know points into the Data window as data. A data weight must 
be entered to satisfy the Data window syntax, even though it is not used. The example data 
and plotted values for the data (f1) are show in Figures 8 and 9, respectively.
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Figure 8
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Figure 9

Once the data has been entered, it can be used for almost any purpose in the model to 
simulate the original unknown function. One common use is to specify a Forcing Function. 
The Forcing Function is useful where a large model is split into two or more sections, and 
the interfaces between the sections are simulated by “forcing” the contents of a 
compartment to be the same as it would have been prior to removing that section of the 
model. To use data for that purpose, double-click on the compartment where the Forcing 
Function is to be applied to open the Compartment Attributes dialog box, and click on the
Forcing Function button. In the Forcing Function dialog, click the Associate with Data 
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radio button and enter the name of the data element in the adjacent entry area. When the 
model is Solved or Fitted, the application  uses linear interpolation on the specified data to 
calculate the quantity in the compartment at any time during the experiment. A Forcing 
Function is an advanced feature of the Compartmental application. More details on how to 
use it are beyond the scope of this discussion.

A more common use is to assign the data values to a variable to simulate the original 
function. For this example, the data for f1 will be used to specify the exogenous input in the 
one compartment model shown in Figure 10.

Figure 10

To do this, double-click the input object ex1 to open the Exogenous Input dialog box. For 
the Input Type, click the Equation radio button. Enter 0.0 for the Event Start time, and 
388.0 for Event Stop. For the equation, enter ex1 = lin(f1). The lin() function invokes the 
SAAM II linear interpolator to calculate the infusion rate at points other than where a value 
is specified in the data. Without this feature, the application would not be able to calculate 
the intermediate values needed for the integration. Note that the infusion times cannot 
extend beyond the first or last data point since the linear interpolator does not extrapolate. 
If the infusion is to run throughout the experiment, the end of the experiment must be 
specified at or prior to the last data point; otherwise the infusion will shut down before the 
experiment ends (in this example it would stop at time 388.0).

After the model has been Solved, a plot of the interpolated ex1 infusion curve 
superimposed on the original f1 data would appear as show in Figure 11. Depending upon 
the other characteristics of the model, the contents of compartment q1 during the 
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experiment would appear similar to Figure 12.

Figure 11
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Figure 12

Q: How can I change the data weighting method within a data column?

A: Unlike a simple spreadsheet, the contents of the Data window are arranged in a specific 
format that allows considerable flexibility, but also insures that the Compartmental and 
Numerical applications can read and interpret it. Each datum is assigned a weight that 
indicates the measure of confidence in that particular value. As explained in the SAAM II 
Help, and the SAAM II Working with Data Tutorial, weight specifications can be entered 

The Epsilon Group ● 2000 Holiday Drive, Charlottesville, Virginia 22901, USA
Telephone: +1.434.923.6093 ● Fax: +1.434.951.0226 ● saam2@tegvirginia.com ● www.saam.com

mailto:saam2@tegvirginia.com
http://tegvirginia.com/solutions/saam-ii/tutorials/basic/
http://tegvirginia.com/solutions/saam-ii/


FAQFAQSS  SAASAAmm II II
Solving (Simulations)

using four formats: SD, FSD, POIS and GEN. In each case, the weight for each datum within 
a data table used internally by the application is determined by converting the weight 
specification to standard deviation, and calculating:

weight = 1.0 / SD^2

The short example below shows several different weighting specifications:

DATA
(FSD 0.12)
t smpl1 smpl2 (SD 1.0)
1.0 67.5 12.6
3.0 46.2 18.1
7.0 31.5 (0.1) 23.9
9.0 27.3 26.5 (2.0)
END

The (FSD 0.12) line assigns Fractional Standard Deviation with a value of 0.12 as the 
weighting method for the entire table. This is applied to each datum in each column unless 
subsequently modified. In column 1, for smpl1, the weight for the data at time 3.0 would be:

weight = 1.0 / (46.2 * 0.12)^2

At the next point at time 7.0, the FSD value has been changed to 0.1 for that datum only, so 
the weight would be:

weight = 1.0 / (31.5 * 0.1)^2

In column 1, then, the weight for each datum is computed using the weighting method 
specified globally by (FSD 0.12), except where the FSD value is specifically modified (at time 
7.0).

In column 2, the weighting method for smpl2 has been modified by the (SD 1.0) entry. This 
tells the application to override the global weighting specified, and to use an SD of 1.0 for 
all of column 2. At time 2.0, for example, the weight would be:

weight = 1.0 / (1.0)^2
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At time 9.0, however, the SD value has been modified to 2.0 and the corresponding weight 
would be:

weight = 1.0 / (2.0)^2

This simple example shows how the weight for each datum can be specified individually, by 
column, or globally for the entire table. It's important to note that, while the weighting 
method can be specified for a table or each column within the table, only the value and not 
the method can be changed for each datum within the column. The answer to the original 
question, then, is that the weighting method cannot be changed within a column, but there 
are workarounds.

DATA
(FSD 0.1)
t smpl1
0.0 0.0 # unacceptable using FSD
2.0 53.4
5.0 226.1
9.0 621.8
END

Supposing, for example, FSD is the preferred weighting method for data collected for an 
infusion starting at time zero, as show in the data table above. A measurement at time zero 
should yield a concentration of 0.0. Unfortunately the value of 0.0 cannot be used with the 
FSD method because is would yield a weight of infinity. How then can this measured value 
be included?

One alternative is to enter a small measurement value instead of 0.0 that would have 
minimal affect upon the optimization, such as 1.0e-6. While this would be reasonable 
computationally, many researchers are hesitant to use “phony” data.

Another way would be to create an additional sample (e.g., s2) that is attached to the same 
compartment and is identical to the first, except for the name. Then associate the second 
sample with a new data element, smpl2, that uses the DS weighting method, and includes 
only the time zero measurement as shown below:
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DATA
(FSD 0.1)
t smpl1
2.0 53.4
5.0 226.1
9.0 621.8
END

# separate table for the time zero measurement of the infusion

DATA
(SD 0.01)
t smpl2
0.0 0.0
END

During a fit, the two data tables and two samples are computationally equivalent to a single 
table and single sample when absolute weighting is used (as set in the Computational 
Settings dialog). When using relative weighting, an additional weighting factor would be 
applied for each table that could affect the computed values.

The most foolproof and flexible alternative uses the GEN wighting method. Using GEN, 
weighting types as well as values can be changed for each datum. Where y is the value at a 
datum, the GEN method is defined as the following:

SD = sqrt(A + B * y ^ C)

To specify an SD of 2.0, use A = SD ^ 2, or:

GEN(4.0 0.0 0.0)

To specify an FSD of 0.1, use B = 0.1 and C = 2.0, or:

GEN(0.0, 0.1, 2.0)

Employing GEN weighting, the data for the previous infusion example could easily be 
accommodated as: 

The Epsilon Group ● 2000 Holiday Drive, Charlottesville, Virginia 22901, USA
Telephone: +1.434.923.6093 ● Fax: +1.434.951.0226 ● saam2@tegvirginia.com ● www.saam.com

mailto:saam2@tegvirginia.com
http://tegvirginia.com/solutions/saam-ii/


FAQFAQSS  SAASAAmm II II
Solving (Simulations)

DATA
(GEN 0.0 0.1 2.0)
t smpl1
0.0 0.0 (0.01 0.0 0.0) # set weight for this point as SD 0.1
2.0 53.4
5.0 226.1
9.0 621.8
END
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